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LESSON 1 -  
EXPLORING ACCESS  

In this lesson, you will learn how to: 

• Start Access  

• Open an existing database  

• Use menu commands  

• Display and hide toolbars  

• Change menu and toolbar options  

• Use database objects  

• Use the Database window  

• Open a database object  

• Use the task pane  

• Exit Access  
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STARTING ACCESS 

 Discussion 
A database is any collection of information organized into a group. The information 
should be organized in a way that allows for easy retrieval. For example, a telephone 
book is a non-computerized database of information. It is organized in alphabetical 
order and includes information such as names, addresses, and telephone numbers. 
Other examples of non-computerized databases include address books and inventory 
lists. 
 
Electronic databases can be maintained on a computer. Computerized databases allow 
you to manipulate large amounts of data quickly and easily. They simplify tasks such 
as searching for specific data, organizing and sorting data, and making corrections or 
changes to data. 
 
In Microsoft Access 2002, the database information is stored in data tables. Every data 
table has a structure that provides for the collection, organization, storage, and 
retrieval of data. These tables of information are contained in a database file. Each 
database file can have numerous data tables. 
 
A data table consists of fields and records. Fields are categories of information. For 
example, in an address table, you may maintain names, addresses, cities, states, and 
zip codes. Each of these categories is a field in the address database. 
 
The set of fields containing the data for a single entry is called a record. For example, 
Charles Hardy, 1234 Main St., Bridgeville, NY, 11012 is a record in the address data 
table. Each piece of information in the record is stored in a field and is referred to as a 
field value. NY is the field value for the State field in this particular record. An 
address table would most likely consist of a number of records, and the data values for 
each record would be stored in the appropriate fields. 
 
Access is a relational database application. A relational database contains a large 
amount of data that is split into numerous tables; each table should include only the 
information pertinent to one subject, such as Customer, Orders, or Items. As a 
result, each table is smaller; more manageable; and, in turn, more efficient. These 
tables can then be joined together to make them related. When tables are related, you 
can access information from any field in any related table, eliminating the need to add 
the same information to more than one table. In addition, you can create reports, 
forms, and queries from data stored in any related table. 
 
In addition to extensive built-in help, the Microsoft Office Assistant is available to 
offer tips and hints for using Access more efficiently. The Office Assistant, a context-
sensitive Help feature, may appear when you start Access. You can adjust the 
capabilities of the Office Assistant, as well as choose not to have the Office Assistant 
appear at all. 
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Another method of obtaining help is the Ask a Question feature. You can type a 
question into the Ask a Question box on the menu bar to get help with a specific 
feature. 
 
Additionally, Office on the Web provides an online link to resources you can use to 
create better databases. For example, you can use Office on the Web to link to Internet 
sites, where you can access technical resources and free product enhancements. 
 
Microsoft Access 2002 is designed to run under the Windows operating system. By 
default, Windows creates a startup command for Access on the Programs submenu, 
which is accessed from the Start menu. Your system may be different, depending on 
how Access was installed or customized. 
 
When you start Access, the New File task pane appears on the right side of the 
application window. The New File task pane provides links for opening existing 
databases, as well as for creating new ones. 
 

  

 
You can create a shortcut on the Windows desktop to start 
Access. 

  

 
The first time you open the Microsoft Access dialog box after 
installation, the list of recently used files and the More Files 
option will not be available in the New File task pane. As you 
begin working with databases in Access, you will be able to 
open recently used files under More Files in the Open a File 
section of the task pane. 

  

 
The first time you open Access after installation, the User 
Name dialog box may appear. You can enter your name and 
initials as necessary, and then select OK. 

  
 

 Procedures 

1. Click the Start button on the taskbar. 

2. Point to Programs. 

3. Select Microsoft Access. 

 



Lesson 1 - Exploring Access Access 2002 - Level 1 

Page 4 Organizational & Staff Development, U of T
 

OPENING AN EXISTING DATABASE 

 Discussion 
An Access database is a collection of information organized into a number of objects 
including tables, queries, forms, reports, pages, macros, and modules. 
 
When you want to work with an Access database, you must first load the database file 
into memory. This process enables you to open all the tables or other objects within 
that database. 
 
You can view or edit an existing database by opening it from disk. You do not need to 
remember the file name because the Open dialog box displays a list of folders and 
files in the current drive and folder. You can select the desired database file from the 
list, or you can type the name of the database you want to open. 
 
If the database resides in a different drive or folder, you can use the Look in list to 
select the correct location. The folders and files residing in the selected location 
appear in the box below the Look in box. 
 
In addition to using the Look in list to open databases, the Open dialog box contains a 
Places Bar on the left side of the dialog box. The Places Bar contains shortcuts to 
various folders containing commonly used files, as well as desktop options and 
recently opened files. 
 
If you want to protect the original version of a database from modifications, you can 
use the Open list to open a copy of the database or the database as read-only. Only 
one database can be open at any time. 

 
The Database window 
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You can also access the Open dialog box by selecting the 
More files link in the New File task pane, or by selecting the 
File menu and then the Open command. 

  

 
Access displays the names of the four most recently opened 
databases at the bottom of the File menu and in the Open a 
file list at the top of the New File task pane. When you click a 
file name in the list, the corresponding database opens. 

  

 
You can use the Tools menu in the Open dialog box to add the 
currently selected folder to the Places Bar. 

  
 

 Procedures 

1. Click the Open button  on the Standard toolbar. 

2. Select the Look in list. 

3. Select the drive where the database you want to open is located. 

4. Open the folder where the database you want to open is located. 

5. Select the name of the database you want to open. 

6. Select Open. 

 

USING MENU COMMANDS 

 Discussion 
The menu bar, located below the application title bar, provides access to all the 
features of Access. Each menu contains commands grouped by function. When you 
select an item on the menu bar, a menu of corresponding commands appears, from 
which you can select the desired command. Some menu commands are dimmed, 
which indicates that the command is not available for the current task. 
 
Each menu appears in two stages, a short menu and a full menu. When you first select 
a menu, the short menu appears and displays the most frequently used commands. 
 
If a command does not appear on the short menu, you can click the double arrows that 
appear at the bottom of the menu. This action expands the short menu to display the 
full menu with all available commands. Once you have expanded a menu, all menus 
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are expanded until you choose a command or perform an action. Other ways to 
expand a menu include double-clicking the menu name on the menu bar or hovering 
over the double arrows or menu name with the mouse pointer. 
 
As soon as you select a command from the full menu, it is added to the short menu. In 
this way, your short menus are updated with the most frequently used commands. 
Commands stay on the short menu until you stop using them for a while or reset your 
data usage. 
 
When a menu command is followed by an ellipsis (...), selecting it opens a dialog box, 
in which additional information is entered. A menu command that displays a right-
pointing triangle indicates a submenu. When you point to this command, the 
associated submenu cascades to the right. 
 
In addition to the standard menus on the menu bar, Access provides shortcut menus 
that are accessed by right-clicking text or an object such as a toolbar. Shortcut menus 
provide commonly used commands and are context-sensitive. Therefore, the options 
available on a shortcut menu vary, depending on the object clicked. 
 

  

 
You can also use key combinations to execute menu 
commands. To display a menu, press the [Alt] key and the 
underlined letter in the menu name. You can then press the 
underlined letter in the desired command to perform the 
action. 

  

 
Some Office XP components are available on an Install on 
First Use basis. This term means that, although the component 
appears on the menu, it is not actually installed until the first 
time you use it. Office XP prompts you to install the 
component and then installs it from the original installation 
source. 

  
 

 Procedures 

1. Click the desired menu. 

2. To display the full menu, click the double arrow at the bottom of the 
short menu. 

3. Click the desired command. 
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DISPLAYING AND HIDING TOOLBARS 

 Discussion 
Toolbars provide shortcuts to menu commands. Each Access toolbar is composed of 
buttons and pull-down lists. Each button executes a specific menu command. 
 
When Access starts, the Database toolbar appears by default below the menu bar. The 
Database toolbar provides buttons for many general Access functions. You can also 
display the Web toolbar, which provides buttons for creating web pages. 
 
In addition to the default toolbars you can select in Access, task-specific toolbars 
appear when you are working in the various views. For example, when you open a 
Table object type, the Formatting (Datasheet), Table Datasheet, and Web toolbars 
are available. 
 
You can choose to display one, several, or all the toolbars at any given time, or you 
can hide all the toolbars to create a larger working area. 
 
Toolbars can be displayed as either docked or floating. A docked toolbar appears at 
one edge of the window, whereas a floating toolbar can be moved to any location on 
the screen. You can also change the size and shape of a floating toolbar. These options 
provide flexibility when you need to display several toolbars at once, or when you 
need to see all the available buttons on a docked toolbar. 
 
When you point to a button on a toolbar, the name of the function associated with it 
appears. This description is referred to as a ScreenTip. Even if a toolbar button is 
dimmed (because it is not available for the current task), the ScreenTip still appears 
when you point to the button. 
 
The Toolbar Options button at the right end of a toolbar can be used to see any 
buttons that do not fit on the docked toolbar. In addition, you can customize any 
toolbar by adding or removing buttons. 
 

  

 
You can also display and hide toolbars by right-clicking any 
toolbar and selecting or deselecting toolbars as desired. A 
checkmark next to the name of a toolbar (selected) indicates 
that it is displayed. 

  

 
If you have hidden all the toolbars, you can redisplay one 
toolbar by selecting the View menu, pointing to the Toolbars 
command, and selecting the toolbar you want to display, or 
you can right-click the menu bar and select the desired toolbar. 
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 Procedures 

1. Select the View menu. 

2. Point to the Toolbars command. 

3. Select the toolbar you want to display or hide. 

 

CHANGING MENU AND TOOLBAR OPTIONS 

 Discussion 
You can change menu and toolbar options in order to adjust the behavior of these 
objects. The Options page in the Customize dialog box allows you to select menu and 
toolbar preferences. If you prefer to see full menus, you can disable the option to show 
recently used commands first. You can also reset any data usage changes that have 
occurred as a result of using the menus and toolbars. 

 
The Customize dialog box 

 
  

 
The Reset my usage data option only affects Access. All 
other options affect all Office XP applications. 
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 Procedures 

1. Select the Tools menu. 

2. Select the Customize command. 

3. Select the Options tab. 

4. To restore toolbars and menus to the default, select Reset my usage 
data. 

5. Select Yes. 

6. To change the menu display, select or deselect the Always show full 
menus option. 

7. Change additional options as desired. 

8. Select Close. 

 

USING DATABASE OBJECTS 

 Discussion 
An Access database file can contain objects such as tables, queries, forms, reports, 
pages, macros, and modules. Database objects are created to input, edit, retrieve, 
display, and print data. You can include up to seven different object types in an 
Access database. A description of each of these object types is listed in the following 
table: 

 
Object Type Object Purpose 

Table This object type defines the structure of an Access 
database. Tables display multiple records in rows and 
columns. Information in these records can be entered, 
edited, stored, and retrieved. 

Query A way of requesting selected information from a 
table. When you run a query, a selected set of records, 
called the recordset, appears. You can then edit or 
print the recordset. 

Form A screen display you can create to show selected 
fields in a record. Forms allow you to enter, view, and 
edit data. You can use a form as an alternative to 
displaying data in rows and columns. 
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Object Type Object Purpose 

Report A design for printed data. Reports can include lists 
and mailing labels, as well as database reports. 
Reports can also perform mathematical operations 
and calculate summaries. 

Page A data access web page used for viewing and working 
with Microsoft Access databases on the Internet or an 
intranet. 

Macro A stored set of Access commands that can be repeated 
as a unit to automate database functions. 

Module This object type stores Visual Basic for Applications 
Edition programming code that can be used to further 
customize and enhance database functions. 

 
When you open a database, all objects in the database are grouped under one of the 
object types listed in the preceding table. These object types, along with their 
corresponding objects, appear in the Database window. 
 

USING THE DATABASE WINDOW 

 Discussion 
When you open a database, it appears in a Database window. The Database window 
provides a toolbar below the title bar, the Objects and Groups bar below the toolbar 
to the left and an object list to the right. The Objects bar displays the various object 
types that are available in Access: Tables, Queries, Forms, Reports, Pages, Macros, 
and Modules. The Groups bar displays the default Favorites group; you can use this 
group to organize related objects in your Access database. You can also create and 
add new groups. 
 
When an object type is selected, all objects (if any) associated with that object type 
appear in the object list. For example, selecting the Queries object type displays all 
query objects in the database and selecting the Forms object type displays all the form 
objects. 
 
Shortcuts also appear in the object list for some object types. These shortcuts enable 
you to create new objects, such as tables, queries, forms, and reports, in Design view 
or using a wizard. 
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The Queries object list 

 
  

 
You can also use the [Ctrl+Tab] key combination to select 
the desired object type in the Objects bar. 

  

 
The toolbar buttons available in the Database window vary 
according to the object type selected. 

  
 

 Procedures 

1. Open the desired database. 

2. Click the desired object type in the Objects bar. 

 

OPENING A DATABASE OBJECT 

 Discussion 
You can open a database object to view the data stored in it. The view in which the 
data appears depends on the type of object you open. Tables and queries appear in 
Datasheet view. Forms appear in Form view. Reports display the data in print 
preview. Macros and modules run programs attached to the object. 
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The Customers table in Datasheet view 

 
  

 
You can also open an object by double-clicking its name in the 
object list. 

  

 
You can use the Close button on the applicable window title 
bar to close a database object (such as a table or form), a 
database, or Access itself. 

  
 

 Procedures 

1. Open the desired database. 

2. Display the desired object list. 

3. Click the name of the object you want to open. 

4. Select the  Open button on the Database window toolbar. 
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USING THE TASK PANE 

 Discussion 
The task pane provides links to many common tasks in Access. For example, you can 
use the New File task pane to create a new, blank database or to open a recently 
modified one. 
 
The task pane is actually comprised of several panes, which can be viewed using the 
Other Task Panes list. The name of the current task pane appears on the task pane 
title bar. You can use the other task panes to perform other tasks in Access, such as 
performing searches and working with the Office Clipboard. 
 
The Back and Forward buttons located on the task pane title bar navigate to 
previously viewed task panes. Blue text in the task pane indicates a link to an action or 
to a dialog box. 
 
You can hide or display the task pane according to your needs. When you open a 
database, the task pane automatically closes. You can display or hide the task pane at 
any time while working with database objects. Although the features in the task pane 
are useful, you may want to hide it to display a larger working area. By default, the 
task pane appears each time you start Access. You can disable this feature by 
deselecting the Show at startup option at the bottom of the New File task pane. 

 
The New File task pane 

 
  

 
Each task pane can be opened with a separate menu command. 
The Task Pane command on the View menu opens the most 
recently used task pane. 
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You can change the size of the task pane by dragging the 
splitter bar (the left border of the task pane) as needed. 

  
 

 Procedures 

1. Select the View menu. 

2. Point to the Toolbars command. 

3. Select the Task Pane command. 

4. To view a different task pane, select the Other Task Panes list on 
the task pane title bar. 

5. Select the desired task pane. 

6. Click the Back or Forward button in the upper left corner of the task 
pane to return to a previous task pane. 

7. Click the desired task pane link. 

8. To close the task pane, click the Close button in the upper right 
corner of the task pane. 

 

EXITING ACCESS 

 Discussion 
In order to be efficient, you should close any objects you are not using. You can have 
several objects open at once, but multiple objects use more system resources. Changes 
to databases are saved automatically when you close the Database window. 
 
In addition, when you have finished using Access, you should exit the application 
properly, since Access performs necessary housekeeping before it closes. If a database 
object has been modified, but not saved, an Access dialog box or the Office Assistant 
prompts you to save the changes before exiting. 
 

  

 
You can also close an object or database by clicking the Close 
button on the applicable window title bar. 

  
 



Access 2002 - Level 1 Lesson 1 - Exploring Access 

Organizational & Staff Development, U of T Page 15
 

 Procedures 

1. Select the File menu. 

2. Select the Exit command. 

 



 

 

LESSON 2 -  
CREATING TABLES  

In this lesson, you will learn how to: 

• Use the Database Wizard  

• Create a new database  

• Design tables  

• Create a table in Design view  

• Use Design view  

• Add field names  

• Assign data types  

• Add a field description  

• Set a primary key  

• Save a new table  

• Use the Table Wizard  
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USING THE DATABASE WIZARD 

 Discussion 
When you create a database in Access, you are creating a container for related tables, 
forms, queries, reports, and other database objects. You can create a new database 
manually or with the help of the Database Wizard. If you create a new database 
manually, you must then create your own tables, queries, and other objects. To save 
time, you can use the Database Wizard. 
 
Access 2002 offers several Database Wizard templates you can use to quickly create a 
database. The Database Wizard templates include preformatted database objects, such 
as tables, forms, and reports. A variety of business and personal Database Wizard 
templates are available on the Databases page in the Templates dialog box. If you use 
any Database Wizard template, Access creates not only the database, but also the 
tables, queries, and other objects in it. 
 
When you use the Database Wizard, you select the fields you want to use in the 
database tables, the desired screen style, and the desired report style. Lastly, you can 
add a database title, include a picture on reports, and choose whether to open the 
database in the Database window or start the database from its Switchboard. The first 
time you start the database, a message box prompts you to enter your name and 
address information. After you have provided this information, the Main Switchboard 
(a form containing command buttons and other objects to help you navigate and use 
the database) opens. 
 
After you have used a Database Wizard template, a link to it appears under New from 
template in the New File task pane. You can click this link to quickly create another 
database using the same template and settings. 

 
Using the Database Wizard to create a new database 
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When you create a new database, it is saved in the default file 
format for Access 2000 so that it can be opened in Access 
2000 as well as Access 2002. To create databases to be used 
strictly in Access 2002, you can change the default file format 
by selecting the Tools menu, the Options command, and the 
Advanced tab in the Options dialog box. Then, select the 
Default File Format list and Access 2002. 

  
 

 Procedures 

1. Click the New button  on the Database toolbar. 

2. Select the General Templates link under New from template in the 
New File task pane. 

3. Select the Databases tab. 

4. Select the desired Database Wizard template. 

5. Select OK. 

6. Type the desired file name. 

7. Select the Save in list. 

8. Select the drive where you want to store the file. 

9. Open the folder where you want to store the file. 

10. Select Create. 

11. Select Next >. 

12. Select the table in the Tables in the database list box for which you 
want to view the fields. 

13. Select or deselect fields in the Fields in the table list box to include 
them in or to exclude them from the database, respectively. 

14. Select Next >. 

15. Select the desired screen style. 

16. Select Next >. 

17. Select the desired report style. 

18. Select Next >. 

19. Type the desired database title. 
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20. Select Next >. 

21. Indicate whether or not you want to start the database after the 
Database Wizard has built it. 

22. Select Finish. 

23. Select OK. 

 

CREATING A NEW DATABASE 

 Discussion 
You can create a new database in Access without using the Database Wizard; 
however, you must then create the tables, queries, and other objects in the database. 
 
When you create a new database, you must specify the desired file name, as well as 
where you want to store the database file. 
 
After you have created the database, the Database window opens. Its toolbar buttons 
allow you to open objects, modify the design of existing objects, and create new 
objects. The Objects bar in the Database window allows you to access the following 
object types: Tables, Queries, Forms, Reports, Pages, Macros, and Modules. 
Created objects can belong to any of these categories. 
 

  

 
The New File task pane closes as soon as you create a new, 
blank database. 

  

 
You can also create a new, blank database by selecting the 
General Templates link on the New File task pane and the 
Blank Database icon on the General page in the Templates 
dialog box. 

  

 
To open the New File task pane, select the File menu and the 
New command. 
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 Procedures 

1. Click the New button  on the Database toolbar. 

2. Select the Blank Database link under New in the New File task 
pane. 

3. Type the desired file name. 

4. Select the Save in list. 

5. Select the drive where you want to store the file. 

6. Open the folder where you want to store the file. 

7. Select Create. 

 

DESIGNING TABLES 

 Discussion 
In Access, there are five steps to designing a table. The first step is to develop a 
thorough understanding of the system, including all the data to be entered and all the 
reports, statistics, labels, and other output you want to generate. It is helpful to gather 
all the forms you use for input and all the reports generated from the data. This 
process serves two purposes. First, these forms and reports are invaluable when you 
begin detailing exactly what information you want stored in each table. Second, once 
you have collected a set of these forms, you can make sure that every item of 
information on your reports is either included in your database or can be derived from 
data in your database. 
 
The second step is to determine how many tables you need and what information to 
store in each table. Once you have gained an overview of the system, you are ready to 
begin designing your database. The most important decision you must make before 
you begin creating tables is how many tables you want the database to include. 
 
The third step is to design the tables by selecting the fields you want to include, the 
type of data you want to store in each field, and the size of the fields. Once you have 
developed an overview of your application and a list of tables, you can make a 
preliminary list of fields, based on the categories of information that each table will 
include. You can refine the list by considering the following: if the data is to be sorted 
or selected, it should be in a separate field; if the data is to be calculated from other 
fields, you do not need to store it in its own field; and, if the table is to be linked to 
another table, both tables should contain common fields. 
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The fourth step is to create the table structures by defining the name, data type, and 
size of the fields. 
 
The fifth and final step is to enter sample data. This step is important because it helps 
you determine whether or not the table fields are the correct size and if all the 
necessary fields have been included. You can then modify the tables as necessary. 
 

CREATING A TABLE IN DESIGN VIEW 

 Discussion 
A table is the basic building block of a database. All queries, reports, and forms use 
the fields and records in the database tables as the basis for their output. You must 
create at least one table in the database before you can create any other object. 
 
When you create a new table, you can use either Datasheet or Design view, work in 
the Table Wizard, import data from another data source, or link to data in another data 
source. Usually, a table is created in Design view, which gives you the most control 
over the database design. 

 
The blank table in Design view 

 
  

 
You can also create a new table in Design view by double-
clicking the Create table in Design view object in the Tables 
object list. 

  

 
Datasheet view displays a grid of rows and columns. Field 
names are entered as column headings. 
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The Table Wizard uses a series of steps to help you create a 
table. You can select a sample table on which to base your 
table and choose field names from commonly used fields, such 
as LastName and CompanyName. 

  
 

 Procedures 

1. Display the Tables objects. 

2. Select the  New button on the Database window toolbar. 

3. Select Design View. 

4. Select OK. 

 

USING DESIGN VIEW 

 Discussion 
The Design view window is split into two panes. The upper pane displays a design 
grid. You can use the rows and columns in this design grid to enter the field names, 
data types, and field descriptions for each field in the table. The small box to the left 
of each field name is the row selector. A black triangle in the row selector indicates 
the current field. 
 
The lower pane displays the properties of the selected field. A property is a 
characteristic of a field, such as the number of characters a field can contain. Access 
automatically assigns default field properties, which you can modify as desired. 
 

  

 
Once you have entered at least one field, you can press the 
[F6] key to move between the upper and lower panes of the 
Design view window. 
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ADDING FIELD NAMES 

 Discussion 
Field names are entered into the Field Name column in the Design view window. 
Field names are labels that identify the data stored in a field. For example, the 
OrderNumber field will most likely contain order numbers. 
 
Field names can be up to 64 characters long and can include letters, numbers, and 
spaces. (Field names, however, cannot begin with a space.) Field names cannot 
contain a period (.), an exclamation point (!), a back quote (`), brackets ([ ]), or ASCII 
control characters. In addition, field names within a table must be unique. 
 
Making field names descriptive and meaningful can help with data entry and data 
retrieval. However, you should avoid long and complicated field names because they 
can be cumbersome to remember and difficult to reference when performing database 
functions. 
 

  

 
The order in which the field names appear in Design view 
determines the order in which the columns appear in Database 
view. 

  

 
Do not include spaces in field names if you work with other 
database formats or plan to use macros with VBA (Visual 
Basic for Applications) code. 

  
 

 Procedures 

1. Open or create a table in Design view. 

2. Type the desired field name. 

3. Press [Down]. 

 

ASSIGNING DATA TYPES 

 Discussion 
The field data type tells Access what kind of values you plan to store in a field and 
how much storage space to set aside for the field. Although you can change a data 
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type after a field contains data, doing so may erase some or all of the information in 
the field. 
 
The following table describes the available data types: 

 
Data Type Description 

Text Text is the default data type; a text field can contain 
any combination of letters, numbers, punctuation 
marks, and spaces. The default width is 50 characters 
and the maximum length is 255 characters. 

Memo A memo field is similar to a text field, except that a 
memo field can contain up to 65,535 characters. You 
can use memo fields for notes or long descriptions in a 
database. 

Number A number field can contain only numeric characters, a 
comma (used as a thousands separator), a period (used 
as a decimal point), and a hyphen (used as a negative 
number sign). You should use a number field only 
when you want to perform calculations using the field 
values. For example, even though zip codes and 
telephone numbers consist of numeric characters, you 
would not use them in calculations; therefore, they 
should be entered in text rather than number fields. 

Date/Time The Date/Time data type is used for dates and/or times. 
Access automatically validates all entries to ensure that 
they are valid dates and/or times. For example, Access 
will not allow you to enter 2/31/99 because February 
does not have 31 days. Date/Time fields are useful in 
performing calculations on dates and times. 

Currency The Currency data type is similar to the Number data 
type and can be used in calculations. However, the 
values in a currency field can have a maximum of four 
decimal places and automatically appear with dollar 
signs and thousands separators (commas). You should 
use currency fields whenever possible because they use 
fixed point calculation, which is faster than the floating 
point calculation used in number fields. 

AutoNumber The AutoNumber data type allows Access to 
automatically assign a unique number (consecutively 
from 1) to each record in the database. You cannot 
manually enter a value into an AutoNumbered field or 
change a number Access has assigned to a record. You 
use this data type when you want a unique 
identification number for each record. 
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Data Type Description 

Yes/No A Yes/No data type is used to signify one of two 
conditions, Yes or No. You use a yes/no field when 
only two possibilities (i.e., True or False) exist for a 
field value. 

OLE object The OLE object data type allows you to either embed 
an object created in another Windows application or 
create a link to such an object. You use an OLE object 
data type for graphics, spreadsheets, or sound files. 

Hyperlink A Hyperlink data type is used to store a link to 
anywhere you choose. The link could go to an Internet 
page, a Word document on an intranet, or even a form 
in the current database. A hyperlink field can contain a 
description, an address, and a sub-address [separated by 
number signs (#)], as well as up to 2,048 characters; 
only the address, however, is mandatory. 

Lookup 
Wizard 

The Lookup Wizard data type allows you to create a 
lookup field. A lookup field displays a list of values 
that are either stored in another table or created by you. 
A lookup field allows you to choose values from a list 
during data entry, thereby reducing repetitive typing 
and eliminating typing errors. 

 

 
Assigning a data type 
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 Procedures 

1. Open or create a table in Design view. 

2. Enter field names as desired. 

3. Select the Data Type column in the field for which you want to 
change the data type. 

4. Select the Data Type list. 

5. Select the desired data type. 

 

ADDING A FIELD DESCRIPTION 

 Discussion 
You can use the Description column in the design grid to enter a description for each 
field. The description appears on the status bar when the field is accessed on a form. 
You can enter brief comments as to the purpose of the field or the data that should be 
stored in it. 
 

 Procedures 

1. Open or create a table in Design view. 

2. Enter field names as desired. 

3. Select the Description column in the field to which you want to add 
a description. 

4. Type the desired description. 

 

SETTING A PRIMARY KEY 

 Discussion 
Access works most efficiently if you specify a primary key for each table. The 
primary key is a field or group of fields that uniquely identifies each record in the 
table. Therefore, the value of the key field, or the combined values of a group of key 
fields, must not be found in more than one record. Consequently, a LastName field 
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would be a poor primary field, because several records may have the same last name; 
it would not, therefore, be unique. 
 
There are several advantages to setting a primary key. First, the primary key is 
automatically indexed, which makes information retrieval faster. Second, when you 
open a table, the records are automatically sorted in order by the primary key. Finally, 
a primary key prevents the entry of duplicate data because Access does not allow 
duplicates in the primary key field. 
 

  

 
If you have trouble identifying the primary key field, you can 
create an AutoNumber field and designate it as the primary 
key. 

  

 
You cannot choose a memo, OLE, or hyperlink field as the 
primary key. 

  

 
To create a multi-field primary key, hold the [Ctrl] key, click 
the desired fields, and then click the Primary Key button on 
the Table Design toolbar. 

  
 

 Procedures 

1. Open or create a table in Design view. 

2. Enter field names as desired. 

3. Select the field you want to designate as the primary key. 

4. Click the Primary Key button  on the Table Design toolbar. 

 

SAVING A NEW TABLE 

 Discussion 
After you have designed the fields for a table, you must save the table before you can 
add any data. When you save a new table, you should give it a name that describes the 
records it stores. You can use up to 64 characters, including spaces. These characters 
can include letters, numbers, and spaces. They cannot contain a period (.), an 
exclamation point (!), a back quote (`), brackets ([]), or ASCII control characters. 
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After you have saved a table, an icon for it appears in the Tables object list in the 
Database window. 
 

  

 
When you save a table for the first time, Access opens the 
Save As dialog box, in which you enter the desired table 
name. 

  

 
When you save a table, you are not creating a file. You are 
adding an object to the existing database. 

  
 

 Procedures 

1. Create a table in Design view. 

2. Enter the desired table data. 

3. Click the Save button  on the Table Design toolbar. 

4. Type the desired table name. 

5. Select OK. 

 

USING THE TABLE WIZARD 

 Discussion 
The Table Wizard leads you through the steps needed to create a new table. The Table 
Wizard provides many table templates for typical business and personal use. You 
select the type of table you want to create, and then the fields you want to add to the 
table. 
 
The Table Wizard allows you to relate your new table to an existing table in your 
database. However, if your database does not contain any tables when you begin the 
Table Wizard, you will not be prompted to relate tables. 
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The Table Wizard 

 
  

 
You can use the right-pointing, double arrow button on the 
first page of the Table Wizard to add all the fields in the 
Sample Fields list to your new table. The left-pointing arrow 
buttons allow you to remove either the selected field or all 
fields from the Fields in my new table list box. 

  

 
You can rename any field in the Fields in my new table list 
box by selecting it and then selecting the Rename Field 
button. 

  

 
You can also activate the Table Wizard by double-clicking the 
Create table by using wizard object in the Tables object list. 

  
 

 Procedures 

1. Display the Tables object list. 

2. Select the  New button  on the Database window toolbar. 

3. Select Table Wizard. 

4. Select OK. 

5. Select the Business or Personal option, as desired. 

6. Select the desired table from the Sample Tables list box. 



Lesson 2 - Creating Tables Access 2002 - Level 1 

Page 30 Organizational & Staff Development, U of T
 

7. Select a field you want to add to your table from the Sample Fields 
list box. 

8. Select  to the right of the Sample Fields list box. 

9. Add other fields as desired. 

10. Select Next >. 

11. Type the desired table name in the What do you want to name your 
table? box. 

12. Select the desired primary key option. 

13. Select Next >. 

14. If you chose to set your own primary key, select the What field will 
hold data that is unique for each record? list. 

15. Select the desired field. 

16. Select the desired data option for the primary key field.  

17. Select Next >. 

18. Review or create table relationships, as desired. 

19. Select Next >. 

20. Select the desired view option. 

21. Select Finish. 

 



 

 

LESSON 3 -  
WORKING WITH TABLES  

In this lesson, you will learn how to: 

• Use Datasheet view  

• Navigate fields in tables  

• Add records  

• Move through records  

• Select records  

• Edit records  

• Save records  

• Delete records  
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USING DATASHEET VIEW 

 Discussion 
When you open a table, it appears in Datasheet view by default. Datasheet view is 
useful when you want to enter, edit, or delete records. 
 
In Datasheet view, the table data is arranged in rows and columns, with the columns 
representing the table fields and the rows the individual records. Multiple records 
appear in the table. The small box at the far left of each row is the record selector; a 
black triangle in the record selector indicates the current record. 
 

NAVIGATING FIELDS IN TABLES 

 Discussion 
In Datasheet view, you can use the mouse or the keyboard to move through the fields 
and records. If there are too many fields to display on screen at the same time, the 
window scrolls automatically as you move to the right or left. 
 
As you enter or edit data, you can use the [Tab] or [Enter] keys to move from field to 
field. You can also use the [Right] and [Left] arrow keys to navigate across fields. 
These keys are helpful because they allow you to keep your hands on the keyboard at 
all times, rather than having to switch back and forth from the keyboard to the mouse. 
However, the mouse is useful if you want to skip certain fields. You simply click in 
the field where you want to enter or edit data. 
 
The [Up] and [Down] arrow keys allow you to move from record to record. In 
addition, the navigation toolbar at the bottom of the datasheet allows you to select the 
first, last, next, or previous record, as well as specify a particular record you want to 
view. 
 

  

 
The [Page Up] and [Page Down] keys scroll to the previous 
or next page of records, respectively. 
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ADDING RECORDS 

 Discussion 
A blank row follows the last record in an existing table. This blank row, the new 
record row, displays an asterisk (*) in the record selector. As soon as you begin 
entering data into the new record row, the asterisk in the record selector changes to a 
pencil to indicate that the record is being entered or edited, and Access creates another 
new record row below it. 
 
If there is no data in the table, only the new record row appears. It does not display an 
asterisk, however; rather, it displays the black triangle that indicates the current 
record. 
 
When you enter data into a row, the amount of characters you can enter is limited by 
the size of the field. The field size, however, can actually be larger than the column 
width in Datasheet view; if the field size is larger than the column width, the text 
scrolls as you type. 
 
After you have typed the desired information into a field, you can press the [Enter] or 
[Tab] key to save the record and move the insertion point to the next field. 

 
Adding records in Datasheet view 

 
  

 
You can use the Clipboard task pane to enter repeated values. 
You can copy as many as 24 separate entries to the Clipboard 
task pane. To display the Clipboard task pane, select the Edit 
menu and then the Office Clipboard command. Copying two 
items in succession also displays the Clipboard task pane. For 
each copied item, the Clipboard task pane displays an icon 
and a portion of the copied or cut text. Clicking an item in the 
Clipboard task pane inserts it into the current field. 
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You can press the [Ctrl+’] key combination to insert the data 
from the corresponding field of the previous record into the 
current field. 

  

 
You can also use the New Record button on the Table 
Datasheet toolbar or at the bottom of the Datasheet view 
window to add a new record. 

  
 

 Procedures 

1. Open the desired table in Datasheet view. 

2. Select the first field in the new record row, if necessary. 

3. Type the desired data. 

4. Press [Enter]. 

5. Enter the desired record data into the remaining fields, pressing 
[Enter] after each entry. 

 

MOVING THROUGH RECORDS 

 Discussion 
If there are more records in a table than can be displayed in Datasheet view, a vertical 
scroll bar appears. You can use this scroll bar to view additional records. 
 
Access also provides a navigation toolbar at the bottom of the datasheet that can be 
used to select the first, last, next, or previous record in the datasheet, as well as to 
specify a particular record you want to view. 
 

  

 
You can also use the [Up] and [Down] arrow keys to move 
from record to record and the [Page Up] and [Page Down] 
keys to display the previous or next page of records, 
respectively. 
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 Procedures 

1. Open a table in Datasheet view. 

2. To move to the last record in the table, click the Last Record button 
 on the navigation toolbar. 

3. To move to the first record, click the First Record button  on 
the navigation toolbar. 

4. To move to the next record, click the Next Record button  on 
the navigation toolbar. 

5. To move to the previous record, click the Previous Record button 

 on the navigation toolbar. 

 

SELECTING RECORDS 

 Discussion 
When you select any field in a record, that record becomes the active record. A black 
triangle appears in the record selector to the left of the record to indicate that it is the 
active record. You can then edit any field in the record as desired. 
 
Selecting a record is different than making a record active. To select a record, you 
must select the entire row. Selecting a record is useful when you want to delete or 
copy it. For example, if you want to add a record containing almost identical 
information as the current record, you can select the current record, copy it, paste it 
into a new record, and then edit it as needed. 
 

  

 
You can also use the [Up] and [Down] arrow keys to activate 
the next or previous record, respectively, and the [Page Up] 
and [Page Down] keys to activate the first record on the 
corresponding datasheet page. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Click anywhere in the record you want to make active. 
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3. Point to the record selector of a record you want to select. 

4. Click in the record selector of the record you want to select. 

 

EDITING RECORDS 

 Discussion 
You can edit records at any time. You cannot edit an AutoNumber field, however, 
because Access automatically generates the data in it. 
 
When you use the keyboard to access a field, the entire field is selected, and you can 
replace all data simply by typing new data. This is select mode. Access also allows 
you to edit individual characters within a field. To do this, you must switch to edit 
mode. In edit mode, the insertion point appears in the field. You can click in a field to 
access edit mode. 
 
While you are editing a record, a pencil appears in its record selector. The following 
table describes various keystrokes you can use to edit records: 

 
Keystroke Description 

[Up] Selects the same field in the previous record. 

[Down] Selects the same field in the next record. 

[Right] In select mode, selects the next field; in edit 
mode, moves one character to the right. 

[Left] In select mode, selects the previous field; in 
edit mode, moves one character to the left. 

[F2] Toggles between select and edit modes. 

[Ctrl+Enter] Inserts a new line character in a field. 

[Ctrl+’] Inserts the data from the corresponding field in 
the previous record. 

[Ctrl+Alt+Spacebar] Replaces the data with the default data, if 
available. 

[Ctrl+Shift+:] In select mode, replaces the field data with the 
current time. 

[Ctrl+;] In select mode, replaces the field data with the 
current date. 
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 Procedures 

1. Open a table in Datasheet view. 

2. Click in the field you want to edit. 

3. Select the text you want to edit. 

4. Type the desired text. 

5. Press [Enter]. 

 

SAVING RECORDS 

 Discussion 
Access automatically saves a new record or changes made to an existing record as 
soon as you move to the next field. You can also save a record manually. This option 
is useful if a record has numerous fields and you want to save the changes made to a 
field without leaving the field. You may also want to save a record manually to save 
changes made to automatically generated data. 
 

  

 
Access also saves records automatically when you close a 
table. 

  

 
You can also press the [Shift+Enter] key combination to save 
a record. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the Records menu. 

3. Select the Save Record command. 
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DELETING RECORDS 

 Discussion 
When you no longer need a record, you can delete it. Deleting records saves disk 
space and keeps your tables smaller and more manageable. 

 
Deleting a record 

 
  

 
After you have deleted a record, you cannot undo the deletion. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the record you want to delete. 

3. Click the Delete Record button  on the Table Datasheet 
toolbar. 

4. Select Yes to delete the record. 

 



 

 

LESSON 4 -  
EDITING TABLES  

In this lesson, you will learn how to: 

• Change the row height  

• Change the column width  

• Change a font attribute  

• Change a cell effect  

• Select a column  

• Move a column  

• Hide a column  

• Unhide a column  

• Freeze a column  
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CHANGING THE ROW HEIGHT 

 Discussion 
In Database view, the default row height is 12.75 points. You can change the row 
height to allow long field entries to wrap. This option allows you to display more of 
the data in a long field entry. 
 
Changing the height of a single row changes the height of every row in the table. 
 

  

 
You can also select the Format menu and the Row Height 
command to change the row height in a table. In the Row 
Height dialog box, you can enter the desired row height or 
select the Standard Height option to reset the row height to 
the default 12.75 points. 

  

 
You cannot use the Undo feature to undo a change in the row 
height. To undo a row height change, you must close the table 
without saving the changes. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Point to any horizontal line between records in the record selector. 

3. Drag the line to the desired row height. 

 

CHANGING THE COLUMN WIDTH 

 Discussion 
In Database view, the standard column width is 15.6667 characters. If a field contains 
a long entry, you can change the column width to display more of the field entry. 
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You can select the Format menu and the Column Width 
command to change the column width in a table. In the 
Column Width dialog box, you can enter the desired column 
width or select the Standard Width option to reset the 
column width to its default 15.6667 characters. 

  

 
You cannot use the Undo feature to undo changes in column 
width. To undo a column width change, you must close the 
table without saving the changes. 

  

 
If you double-click the column separator line to the right of 
any column header, the width of that column automatically 
adjusts to display the longest entry in the column. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Point to the vertical line to the right of the header of the column you 
want to adjust. 

3. Drag the line to the desired width. 

 

CHANGING A FONT ATTRIBUTE 

 Discussion 
You can change datasheet font attributes. The font attributes affect the appearance of 
the data and column headings. You can change the font type, style, and size, as well as 
add or remove font effects. 
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The Font dialog box 

 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the Format menu. 

3. Select the Font command. 

4. Select the desired options. 

5. Select OK. 

 

CHANGING A CELL EFFECT 

 Discussion 
You can change the appearance of cells in Datasheet view. For example, you can 
make cells raised or sunken. You can also change the look of the horizontal and 
vertical gridlines, and the cell background. 
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The Datasheet Formatting dialog box 

 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the Format menu. 

3. Select the Datasheet command. 

4. Select the desired option. 

5. Select OK. 

 

SELECTING A COLUMN 

 Discussion 
Before you can manipulate table columns, you must select them. You can perform a 
number of actions on selected columns, as well as select a single column or multiple 
adjacent columns. 
 

  

 
Column headers are also called field selectors. 
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To select multiple adjacent columns, drag across the headers 
of the columns you want to select. 

  

 
Right-clicking a column header selects the column and 
displays the column shortcut menu at the same time. The 
shortcut menu provides access to common column commands, 
such as changing column width or hiding columns. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Click the header of the column you want to select. 

 

MOVING A COLUMN 

 Discussion 
You can move one or more columns in Datasheet view. For example, you can 
reposition columns to view data more easily or organize the datasheet logically. 
 
You can move a single column or multiple, adjacent columns. Before you can move a 
column or multiple columns, however, you must first select them. 
 

  

 
Moving columns does not change the order of the fields in the 
table design. 

  

 
To undo a column move, you must close the table without 
saving the changes. You cannot use the Undo feature to undo 
a column move. 

  

 
When you are dragging a column to move it, a vertical divider 
bar appears in the destination location when the mouse pointer 
is correctly positioned. 

  
 



Access 2002 - Level 1 Lesson 4 - Editing Tables 

Organizational & Staff Development, U of T Page 45
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the column you want to move. 

3. Drag the column to the new location. 

 

HIDING A COLUMN 

 Discussion 
If you do not regularly view or edit one or more table fields, you can hide their 
corresponding table columns. Hiding columns can make your datasheet narrower and 
easier to view.  
 
You can hide a single column or multiple adjacent columns. 
 

  

 
You can also use the Hide Columns command on the column 
header shortcut menu to hide the current column. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the column you want to hide. 

3. Select the Format menu. 

4. Select the Hide Columns command. 

 

UNHIDING A COLUMN 

 Discussion 
You can redisplay hidden columns. The Unhide Columns dialog box lists all the 
columns in the table, with a check box to the left of each column name. The check box 
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is deselected for hidden columns. You can select the check box to redisplay a hidden 
column. 

 
The Unhide Columns dialog box 

 
  

 
You can also use the Unhide Columns dialog box to hide 
multiple, non-adjacent columns. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the Format menu. 

3. Select the Unhide Columns command. 

4. Select the column you want to unhide. 

5. Select Close. 
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FREEZING A COLUMN 

 Discussion 
If you have a table with multiple fields, all of the columns may not display on screen 
at the same time. You can scroll to the right to view additional columns; however, you 
may not be able to see the columns at the far left, which may display necessary 
information, such as the record identification. 
 
You can freeze columns in Datasheet view. Freezing one or more columns allows 
you to see the information in the frozen columns no matter how many columns you 
scroll to the right. 
 

  

 
You can also use the Freeze Columns command on the 
column header shortcut menu to freeze the current column. If 
you freeze a column other than the first column, however, the 
frozen column moves to the far left position in the datasheet. 

  

 
A solid, dark line appears to the right of the last frozen 
column. 

  

 
To unfreeze columns, select the Format menu and the 
Unfreeze All Columns command. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the column you want to freeze. 

3. Select the Format menu. 

4. Select the Freeze Columns command. 

 



 

 

LESSON 5 -  
FINDING AND FILTERING DATA  

In this lesson, you will learn how to: 

• Sort records  

• Find specific records  

• Find records using wildcards  

• Use Replace  

• Use Filter By Selection  

• Apply/Remove a filter  

• Use Filter Excluding Selection  

• Use Filter For  

• Use Filter By Form  
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SORTING RECORDS 

 Discussion 
When you display a table in Datasheet view, Access displays the records in order by 
their primary key. You may want to edit or print records in a different order (e.g., by 
last name, zip code, or amount due). 
 
You can sort records in either ascending or descending order. Ascending order sorts 
numerically from 0 to 9 and then alphabetically from A to Z. Descending order sorts 
numerically from 9 to 0 and then alphabetically from Z to A. The Table Datasheet 
toolbar provides buttons for both ascending and descending sorts. 
 

  

 
You can remove a sort by selecting the Records menu and the 
Remove Filter/Sort command. 

  

 
You can also sort records by selecting the Records menu, 
pointing to the Sort command, and selecting the desired sort 
command, or by right-clicking in the field you want to sort 
and selecting the desired sort command. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the field by which you want to sort. 

3. Click the Sort Ascending button  or the Sort Descending 

button  on the Table Datasheet toolbar. 

 

FINDING SPECIFIC RECORDS 

 Discussion 
The Find feature allows you to locate records quickly. You can search for records that 
contain a unique value in a certain field, or you can find all records that have a 
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common value in a field. Access scans the selected field, beginning with the current 
record, and highlights the first instance of the search text it finds. You can repeat the 
search to find additional records containing the same data. 
 
In the Find and Replace dialog box, you can select options to control how Access 
searches for matching records. You can use the Look In list to search the current 
column or the entire table. The options on the Match list allow you to specify whether 
to match any part of the field, the whole field, or only the start of the field. 
 
The Find and Replace dialog box remains open during a search. If needed, you can 
move the dialog box out of the way to view the search as it progresses. 

 
The Find and Replace dialog box 

 
  

 
The Find and Replace dialog box retains the settings of the 
most recent search. Pressing the [Shift+F4] key combination 
performs the same search again. 

  

  
You can also open the Find page in the Find and Replace 
dialog box by selecting the Edit menu and the Find command. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the field you want to search. 

3. Click the Find button  on the Table Datasheet toolbar. 

4. Type the text you want to find in the Find What box. 

5. Select the Match list. 

6. Select the desired option. 

7. Select Find Next to begin the search. 
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8. Select Find Next to find the next matching record. 

9. When all records have been searched, select OK. 

10. Select Cancel to close the Find and Replace dialog box. 

 

FINDING RECORDS USING WILDCARDS 

 Discussion 
You can use wildcards in a find. Wildcards are characters that represent other 
characters. They allow you to find records, even if you are not sure how the entry 
appears in the field. Wildcards also allow you to find records that share a common 
entry within a field, but not necessarily the entire field entry. For example, you may 
want to search for the area code at the beginning of a telephone number field. 
 
You can use the following wildcards in a find: 

 
Wildcard Description 

* Represents any number of characters. It can be used 
anywhere in the search text. For example, North* will 
find all entries beginning with the word North; *Sports 
will find all entries ending with the word Sports; and 
*Sports* will find all entries containing the word Sports. 

? Represents only one character; for example, Sm?th will 
find Smith, Smyth, etc. 

[ ] Finds any character enclosed in the set; for example, 
b[ai]t will find bat and bit, but not bet and but. 

! Finds any character except the ones enclosed in the set; 
for example, b[!ai]t will find bet and but, but not bat or 
bit. 

- Finds any character in a range in a set; for example, 
b[u-w]t finds but, bvt, and bwt. 

# Represents only one digit; for example, 1980# finds 
19801, 19802, 19803, etc. 
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 Procedures 

1. Open a table in Datasheet view. 

2. Select the field you want to search. 

3. Click the Find button  on the Table Datasheet toolbar. 

4. Type the text you want to find in the Find What box. 

5. Select the Match list. 

6. Select the desired option. 

7. Select Find Next to begin the search. 

8. Select Find Next to find the next matching record. 

9. When all records have been searched, select OK. 

10. Select Cancel. 

 

USING REPLACE 

 Discussion 
The Replace feature allows you to quickly locate and replace data in a field. This 
feature is especially useful if the same information must be changed in several 
records. Access scans the selected field, beginning with the current record, and selects 
the first instance of the search text it finds. You can replace the text or search for the 
next instance of the search text. You can also replace all the instances of the search 
text at once. 
 
In the Find and Replace dialog box, you can control how Access searches for 
matching records. The Look In list enables you to search either the current column or 
the entire table. The options on the Match list allow you to specify whether to match 
any part of the field, the whole field, or only the start of the field. 
 
The Find and Replace dialog box remains open during a search. You can move it as 
needed to view the datasheet records. 
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Replacing data 

 
  

 
You can also display the Replace page in the Find and 
Replace dialog box by selecting the Edit menu and the 
Replace command. 

  
 

  

 
Selecting the Replace All button in the Find and Replace 
dialog box replaces all data that matches the search text. Make 
sure that you want to replace all data before you use the 
Replace All button because you may not be able to retrieve 
the data once it has been replaced. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the field you want to search. 

3. Click the Find button  on the Table Datasheet toolbar. 

4. Select the Replace tab. 

5. Type the text you want to find in the Find What box. 

6. Select the Replace With box. 

7. Type the desired replacement text. 

8. Select Find Next to begin the search. 

9. Select Replace. 

10. Select Replace All. 

11. Select Yes to replace all remaining matches. 
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12. Select Cancel. 

 

USING FILTER BY SELECTION 

 Discussion 
You can filter data in Access. Filtering data allows you to view only those records 
with which you want to work by hiding the records you do not want to see. For 
example, you can filter data in a customers table so that only the records of those 
customers located in a specific region appear. 
 
A quick and easy way to filter data in Access is to use the Filter By Selection feature, 
in which only those records that match the data in the selected field are displayed. 
 
A filter remains in effect until you remove it. 

 
A filtered table 

 
  

 
When a filter is in effect, the (Filtered) indicator appears on 
the status bar. 

  

 
You can also filter by selection by selecting the Records 
menu, pointing to the Filter command, and selecting the 
Filter By Selection command, or by right-clicking the field 
containing the value by which you want to filter and selecting 
the Filter By Selection command. 
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 Procedures 

1. Open a table in Datasheet view. 

2. Select any field that contains the data by which you want to filter. 

3. Click the Filter By Selection button  on the Table Datasheet 
toolbar. 

 

APPLYING/REMOVING A FILTER 

 Discussion 
The Apply Filter button acts a toggle. If a filter is in effect, it becomes the Remove 
Filter button. If no filter is in effect, it applies the most recent filter when you click it. 
 

  

 
You can also reapply the previous filter by selecting the 
Records menu and the Apply Filter/Sort command. 

  

 
You can also remove a filter by selecting the Records menu 
and the Remove Filter/Sort command or by right-clicking 
any field and selecting the Remove Filter/Sort command. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Click the Apply Filter or Remove Filter button  on the Table 
Datasheet toolbar, as applicable. 
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USING FILTER EXCLUDING SELECTION 

 Discussion 
The Filter Excluding Selection feature is similar to the Filter by Selection feature 
except that it displays all records that do not match the filter criteria. For example, if 
most of the customers in a customers table are located in the state of New York, you 
can use the Filter Excluding Selection feature to display only those records in which 
the customers are not located in New York. 
 

  

 
You can also enable the Filter Excluding Selection feature by 
right-clicking any field containing the value you want to 
exclude and selecting the Filter Excluding Selection 
command. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the field that contains the data you want to exclude. 

3. Select the Records menu. 

4. Point to the Filter command. 

5. Select the Filter Excluding Selection command. 

 

USING FILTER FOR 

 Discussion 
The Filter For feature allows you to quickly display records containing specific data 
in a field. When you apply this type of filter, Access filters the table and displays only 
those records containing data that matches the filter. 
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Using Filter For 

 
  

 
You can use wildcards with the Filter For feature. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Right-click the field by which you want to filter. 

3. Select the Filter For command. 

4. Type the desired filter. 

5. Press [Enter]. 

 

USING FILTER BY FORM 

 Discussion 
You can use the Filter By Form feature to filter data. The Filter By Form feature 
displays a blank record in the Filter by Form window. You enter the data by which 
you want to filter in the corresponding field. When the filter is applied, only those 
records with matching data appear; all the other records are hidden. 
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The Filter by Form feature allows you to filter by more than one field. This feature is 
especially useful when you are filtering a large database with many fields and/or 
records. 
 
All fields in the Filter By Form window have a lookup list that displays existing field 
data so that you can easily choose the data by which you want to filter. These lookup 
lists are useful because you do not have to remember exactly how the data was entered 
into the field. 

 
The Filter by Form window 

 
  

 
The most recent filter appears in the Filter by Form window, if 
applicable; you can click the Clear Grid button on the 
Filter/Sort toolbar to clear the previous filter. 

  

 
You can also enable the Filter By Form feature by selecting 
the Records menu, pointing to the Filter command, and 
selecting the Filter By Form command. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Click the Filter By Form button  on the Table Datasheet 
toolbar. 
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3. Click the Clear Grid button  on the Filter/Sort toolbar to clear 
the previous filter, if necessary. 

4. Select the field by which you want to filter. 

5. Select the field lookup list. 

6. Select the data by which you want to filter. 

7. Click the Apply Filter button  on the Filter/Sort toolbar. 

 



 

 

LESSON 6 -  
PRINTING DATA  

In this lesson, you will learn how to: 

• Print table data  

• Change the page setup  

• Use print preview  

• Print selected records  
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PRINTING TABLE DATA 

 Discussion 
You can print table data from either the Database window or Datasheet view. When 
you use the Print button, Access uses the default printer settings. 
 
If there are too many fields to fit on one page, Access prints as many fields as possible 
on the first page and then prints additional pages for the next set of fields, etc., until 
all the fields have been printed. If you have a large table with multiple fields, the 
printout could result in many pages of disjointed information. Consequently, the Print 
button is best utilized for printing smaller, more compact tables. 
 

  

 
If a filter is applied, only the displayed records will print. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Click the Print button  on the Table Datasheet toolbar. 

 

CHANGING THE PAGE SETUP 

 Discussion 
You can control how a table is printed by changing the page setup options. You can 
adjust the margins, as well as change the page orientation so that more data can fit on 
fewer pages. 
 
On the Margins page in the Page Setup dialog box, you can change the size of the 
margins and choose whether or not to print column headings. On the Page page, you 
can select either portrait orientation (with the shorter edge of the page at the top) or 
landscape orientation (with the longer edge of the page at the top). You can also 
choose a different paper size, paper source, and printer. 
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The Page Setup dialog box 

 
  

 
You can also open the Page Setup dialog box by selecting the 
Setup button in the Print dialog box. 

  

 
Print settings are saved for forms and reports, but not for 
tables. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the File menu. 

3. Select the Page Setup command. 

4. Select the desired options. 

5. Select the Page tab. 

6. Select the desired options. 

7. Select OK. 
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USING PRINT PREVIEW 

 Discussion 
Before printing, you can preview a table to see how the data appears on each page. 
The Print Preview feature displays the pages as they will appear when printed, 
including all aspects of the layout. You can use the Print Preview feature to preview 
the appearance of your printed pages before printing them; thereby allowing you to 
make additional changes. 
 
The default view in print preview displays the full page, making the print difficult to 
read; however, you can increase the magnification of the page by zooming print 
preview. This option makes the text easier to read. When the mouse pointer is 
positioned over the page, it changes into a magnifying glass. When you click the page 
with the magnifying glass, the magnification increases so that you can read the area of 
the page you clicked. When you click the page again, the magnification returns to full 
page view. 
 
If your table contains multiple pages, you can view several pages at one time. The 
page images are reduced as necessary to fit in the print preview window. The pages 
displayed initially depend upon the location of the insertion point when you access the 
Print Preview feature. 

 
Print preview 

 
  

 
You can also use the Page buttons at the bottom of the print 
preview window to move between pages. 
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Clicking the Setup button on the Print Preview toolbar opens 
the Page Setup dialog box. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Click the Print Preview button  on the Table Datasheet 
toolbar. 

3. Click the area of the page you want to magnify. 

4. Click anywhere in the page to return to full page view. 

5. Press [Page Down] or [Page Up] to display the next or previous 
page of the printout, respectively. 

6. To view more than one page at a time, click and hold the Multiple 

Pages button . 

7. Select the desired page layout. 

8. To view a single page, click the One Page button . 

9. Select Close. 

 

PRINTING SELECTED RECORDS 

 Discussion 
You can print selected, adjacent records. You can print selected records by first 
selecting the records in the table and then selecting the Selected Records(s) option in 
the Print dialog box. 
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Printing selected records 

 
  

 
You can also select other options in the Print dialog box, such 
as the number of copies you want to print. 

  

 
You can select multiple, adjacent records by selecting the first 
record you want to print, holding the [Shift] key, and clicking 
the last record you want to print. 

  
 

 Procedures 

1. Open a table in Datasheet view. 

2. Select the records you want to print. 

3. Select the File menu. 

4. Select the Print command. 

5. Select the Selected Record(s) option under Print Range. 

6. Select OK. 

 



 

 

LESSON 7 -  
USING SIMPLE QUERIES  

In this lesson, you will learn how to: 

• Use queries and recordsets  

• Use the Simple Query Wizard  

• Create a query in Design view  

• Open a query  

• Add a table to a query  

• Join tables in a query  

• Run a query  
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USING QUERIES AND RECORDSETS 

 Discussion 
A query is a means of extracting information from tables. You can use queries to 
analyze the data in a table or to extract data for a form or report. Queries are 
commonly used to display data in related tables and enable you to control not only 
which records to display, but also which fields. For example, you may want to give a 
sales representatives a list of the contacts and telephone numbers for a particular 
region; you can create a query to extract just the contact names and telephone 
numbers within the specified region. 
 
A query does not contain data; rather, it is a set of instructions. Access uses these 
instructions to select and display the desired records in a table. As a result, whenever 
new data is added to the queried table, the query is automatically updated; if the new 
records meet the conditions of the query, they will be included when the query runs. 
 
When you open or run a query, a recordset appears. A recordset contains all the fields 
and records that meet the conditions of the query. Although the recordset is not a 
table, it can be used to edit or add new records in the queried tables. 
 

USING THE SIMPLE QUERY WIZARD 

 Discussion 
The Simple Query Wizard guides you through the steps for creating a basic select 
query. When you use the Simple Query Wizard, you select the table you want to use 
and the fields you want the query to display. Then, you name the query and choose 
whether to display the results of the query (recordset) or go to Design view to work 
with the query design. 
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Adding fields to a query 

 
  

 
You can also activate the Simple Query Wizard by double-
clicking the Create query by using wizard option in the 
Queries object list in the Database window or by selecting the 
Insert menu and the Query command. 

  

 
You can also add fields to the Selected Fields list by double-
clicking the name of the field in the Available Fields list. 

  
 

 Procedures 

1. Display the Queries object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Simple Query Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query you want to query. 

7. Select the first field you want to add to the query from the Sample 
Fields list box. 

8. Select the arrow  to the right of the Sample Fields list box. 
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9. Add other fields to the Selected Fields list box, as desired. 

10. Select Next >. 

11. Type the desired query name. 

12. Select Finish. 

 

CREATING A QUERY IN DESIGN VIEW 

 Discussion 
You can create a query in Design view. This option gives you the most flexibility in 
designing a query. It allows you to add criteria for selecting records, as well as sort the 
recordset. 
 
When you create a query in Design view, the design grid is used to set up the query. 
The field lists of all tables to be used in the query appears in the top pane. The design 
grid appears in the bottom pane. You drag the fields you want to use in the query to 
the design grid and then add the desired criteria and sorts. 

 
Creating a query in Design view 

 
  

 
You can also open Design view by double-clicking the Create 
query in Design view option in the Queries object list. 

  

 
You can also add a field to a query by clicking in any blank 
column in the Field row, clicking the drop-down arrow, and 
then selecting the field you want to add, or by dragging the 
field to the design grid. 

  

 
You can add all the fields to the design grid by dragging the 
asterisk (*) at the top of the field list to the Field row in any 
column. 
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 Procedures 

1. Display the Queries object list. 

2. Click the  New button on the Database window toolbar. 

3. Select Design View. 

4. Select OK. 

5. Add the table you want to query. 

6. Select Close. 

7. Add the desired fields to the query. 

8. Click the Save button . 

9. Type the desired query name. 

10. Select OK. 

 

OPENING A QUERY 

 Discussion 
When you open a query, Access runs the query and displays its recordset in Datasheet 
view. If you have added records since the last time you ran the query, the new records 
will appear as long as they meet the query criteria. 
 

  

 
You can also run a query by selecting it in the Queries object 
list and then selecting the Open button or by right-clicking it 
and then selecting the Open command. 

  
 

 Procedures 

1. Select the Queries object list. 

2. Double-click the name of the query you want to run. 
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ADDING A TABLE TO A QUERY 

 Discussion 
You can use more than one table in a query. The tables must be joined, however, in 
order for the query to produce accurate results. If the tables are not yet joined, you can 
create a join in the top pane of Design view. 
 
The field lists of all tables added to a query appear in the top pane of Design view. If 
the tables are already related, join lines appear as well. 
 
Once you have added a table to a query, you can then add fields from its field list to 
the design grid. The Table row in the design grid indicates the table in which a field is 
stored. 
 
When you create a new query in Design view, the Show Table dialog box opens 
automatically so that you can add the desired tables. However, when you modify an 
existing query in Design view, you must manually open the Show Table dialog box. 
 

  

 
You can also open the Show Table dialog box by right-
clicking in the top pane of Design view and then selecting the 
Show Table command or by selecting the Query menu and 
the Show Table command. 

  
 

 Procedures 

1. Select the Queries object list. 

2. Select the query you want to edit. 

3. Select the  Design button on the Database window toolbar. 

4. Click the Show Table button  on the Query Design toolbar. 

5. Double-click the table you want to add to the query. 

6. Select Close. 
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JOINING TABLES IN A QUERY 

 Discussion 
If you have multiple tables in a query, the tables must be joined in order for the query 
to produce accurate and meaningful results. Otherwise, Access will not know which 
records are associated with which, so every possible combination of records would 
appear in the recordset. For example, if one table has 20 records and the other has 5, 
then the recordset will contain 100 records and the results are virtually meaningless. 
 
If table relationships have already been defined, the join lines appear automatically in 
Design view. In addition, Access will automatically create a join if there are fields 
with the same name in multiple tables. If Access cannot define the relationships 
between query tables, you must create them. 
 
The join type defined in the relationship is particularly important in queries. The 
default type is an inner join, in which records are only included in the recordset if 
there is matching data in the join fields of both tables. You can also create an outer 
join, in which all the records from the “one” table appear, even if there is no matching 
data in the “many” table. 

 
Joining tables in a query 

 
  

 
Joins that you define in a query do not appear in the 
Relationships window. 

  

 
You can remove a join line from a query by selecting it and 
then pressing the [Delete] key. You must remove referential 
integrity before deleting a join. 

  

 
You can also open the Join Properties dialog box by right-
clicking the join line and selecting the Join Properties 
command or by selecting the View menu and the Join 
Properties command. 
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 Procedures 

1. Open the desired query in Design view. 

2. Add a new table to the query, if necessary. 

3. Drag the desired join field from one field list to the matching field in 
a second field list. 

4. Double-click the middle segment of the join line. 

5. Select the desired join type. 

6. Select OK. 

 

RUNNING A QUERY 

 Discussion 
You can run a query and display its recordset directly from Design view. This option 
is useful for testing the query design to see if its recordset contains the desired 
information. 
 
Running a query does not save the query design. If you close the recordset after 
running a query, you are prompted to save the changes. 
 

  

 
You can also run a query by selecting the Query menu and the 
Run command. 

  

 
After running a query, you can switch back to Design view by 
clicking the View button on the Query Datasheet toolbar. 

  
 

 Procedures 

1. Open a query in Design view. 

2. Click the Run button  on the Query Design toolbar. 

 



 

 

LESSON 8 -  
MODIFYING QUERY RESULTS  

In this lesson, you will learn how to: 

• Sort a query  

• Add criteria to a query  

• Hide a field in a query  

• Add a record using a query  

• Print a query  
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SORTING A QUERY 

 Discussion 
When you run a query, the records in the recordset appear in the same order in which 
they appear in the design grid. You can either sort the recordset or assign a sort order 
in the query design. You can sort a recordset just as you would sort a table; however, 
you would have to perform the sort every time you run the query. If you assign a sort 
order in the query design, Access will sort the recordset automatically each time you 
run the query. 
 
You can sort on more than one field. For example, you can sort by region and then by 
states within each region. To sort on more than one field, the first sort field must be to 
the left of the second sort field in the query design grid, since Access sorts from left to 
right. 

 
Adding a sort order to the design grid 

 

 Procedures 

1. Open a query in Design view. 

2. Select the Sort row for the field by which you want to sort. 

3. Select the Sort list. 

4. Select the desired sort option. 
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ADDING CRITERIA TO A QUERY 

 Discussion 
You can use the Criteria row in the design grid to restrict the number of records a 
query returns. 
 
To select records that match a single value, you can enter the value you want to match 
in the Criteria row of the applicable field. Access automatically inserts quotation 
marks (" ") around alphanumeric entries and number symbols (#) around date entries; 
nothing appears around numeric entries. When you run the query, only those records 
with values that match the criteria appear in the recordset. 

 
Adding criteria to a query 

 
  

 
A field name in the Criteria row must be entered exactly as it 
appears in the field list. 

  
 

 Procedures 

1. Open a query in Design view. 

2. Select the Criteria row for the field you want to match. 

3. Type the value you want to match. 

4. Press [Enter]. 
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HIDING A FIELD IN A QUERY 

 Discussion 
You can select records that meet specified field criteria without displaying the field in 
the recordset. This option is useful when all the records meet the same specified 
criteria and, as a result, the field does not need to appear. 
 
For example, you may create a query to display customers in the Southeast region. 
The Region field must be added to the query with a criterion of Southeast; since all 
the data in the Region field would be the same (Southeast), the Region field does not 
need to appear in the recordset. In this case, you can hide the Region field. 
 
The design grid provides a Show row for each field. If the Show option is selected, 
the field will appear in the recordset; if it is deselected, the field will not appear in the 
recordset. The Show option is selected by default. 
 

 Procedures 

1. Open a query in Design view. 

2. Deselect the Show option in the field you want to hide. 

 

ADDING A RECORD USING A QUERY 

 Discussion 
You can use a query to update records in related tables. When you enter data into a 
query recordset, Access automatically completes the recordset data, as applicable, and 
enters the data into the related tables as well. For example, if you run a query using 
the related Orders and Customers tables and you enter a new order into the 
recordset, Access automatically completes the customer information in the recordset 
and enters the data into the Orders table as well. 
 
You can always edit information in queries based on a single table. In queries based 
on related tables, Access must be able to determine the relationship type (one-to-one 
or one-to-many) in order for you to be able to edit information. In queries based on a 
one-to-one relationship, you can always edit the data. In queries based on a one-to-
many relationship, you may not always be able to edit the data. For instance, this can 
happen if the join field from the “many” table is not included in the query. For 
example, you cannot add a new customer order to a query recordset based on the 
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related Customers and Orders table unless the join field (Customer ID) in the 
Orders table is included in the query. 
 

  

 
You can use help to get more information about using a query 
to update data in tables having a one-to-many relationship. 

  
 

 Procedures 

1. Open a query in Datasheet view. 

2. Click the New Record button  on the Query Datasheet 
toolbar. 

3. Type the desired data into the first field. 

4. Select the next field. 

5. Enter data into each of the remaining fields, as desired. 

6. Press [Enter]. 

 

PRINTING A QUERY 

 Discussion 
You can print a query recordset. You can run the query and then print the recordset, or 
you can save time by printing the recordset directly from the Database window. If you 
print the recordset from the Database window, Access runs the query and sends the 
results directly to the printer, rather than to the screen. 
 

 Procedures 

1. Select the Queries object list. 

2. Select the query you want to print. 

3. Click the Print button  on the Database toolbar. 

 



 

 

LESSON 9 -  
USING OPERATORS IN QUERIES  

In this lesson, you will learn how to: 

• Use comparison operators  

• Use an And condition  

• Use an Or condition  

• Use the Between And operator  

• Use the Expression Builder  

• Use a wildcard character  
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USING COMPARISON OPERATORS 

 Discussion 
You can add criteria to a query in order to limit the number of records in the recordset. 
The simplest criterion is to find all records matching a single value. 
 
You can also use comparison operators to limit the recordset to a group of records. 
Comparison operators are symbols that represent conditions recognized by Access. 
The following comparison operators are available in Access: 

 
Operator Description 

< less than 
<= less than or equal to 
> greater than 

>= greater than or equal to 
= equal to 

<> not equal to 
Not reverses logic 

 
You can use one or more comparison operators to compare a specified value to all the 
values in a field. For example, you may want to find all customers with credit limits of 
less than $1000 or all customers with a contract date on or before January 2001; you 
can use a combination of comparison operators and field values to write an expression 
defining the desired criteria (e.g., <1000 or <=1/1/01, respectively). 
 
When you run the query, only those records with values meeting the specified criteria 
appear in the recordset. 

 
Adding criteria to a query 
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Access automatically inserts number symbols (#) around date 
values and quotation marks (" ") around alphanumeric values. 
Access does not insert any symbols or characters around 
numeric values. 

  

 
You can also use the Expression Builder to add criteria to a 
query. To open the Expression Builder, select the Criteria 
row in the field to which you want to add criteria and click the 
Build button on the Query Design toolbar or right-click the 
Criteria row and select the Build command. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row in the field to which you want to add criteria. 

3. Type the desired comparison operator and value.  

4. Press [Enter]. 

 

USING AN AND CONDITION 

 Discussion 
Many times, a query requires more than one condition to obtain the desired result. If 
you want to find all customers in PA with sales to date of over $10,000, for example, 
you need two conditions: State=PA and Sales to Date>10000. The records must meet 
both conditions in order to be included in the recordset. When two or more criteria 
must be met, you are creating an And condition. An And condition is created using the 
And logical operator. 
 
You can create an And condition by adding multiple criteria to a single field. In order 
to do this, you must use the And operator to find records that fall within a range. For 
example, to find customers whose contract dates fall between 9/1/99 and 9/30/99, you 
would type both criteria on a single line in the Criteria row of the appropriate field 
(i.e., >=9/1/99 And <=9/30/99 in the Contract Date field). 
 
An And condition is assumed when you enter conditions in the same Criteria row of 
two or more different fields; in this case, the And operator is unnecessary. For 
example, to find customers in PA with sales to date of over $10,000, you would type 
each criterion in the same Criteria row of the appropriate fields (i.e., =PA in the first 
Criteria row of the State/Province field and >10000 in the first Criteria row of the 
Sales to Date field). 
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Criteria entered in the same row of the design grid create an 
And condition, and criteria entered in different rows create an 
Or condition. 

  

 
You can also use the Expression Builder by selecting the 
desired Criteria row and clicking the Build button on the 
Query Design toolbar or by right-clicking the Criteria row 
and selecting the Build command. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row of the desired field. 

3. Type the desired criterion. 

4. Type the And operator and an additional criterion in the same 
Criteria row and field or type additional criteria in the same 
Criteria row of one or more other fields. 

5. Press [Enter]. 

 

USING AN OR CONDITION 

 Discussion 
There are times you may want to find records that meet only one of several specified 
conditions. This is called an Or condition. If you want to find all customers in PA or 
all customers with sales to date of over $10,000, for example, you would need two 
conditions: State=PA and Sales to Date>10000. A record needs to meet only one of 
the conditions in order to be included in the recordset. 
 
You can create an Or condition in a single field by entering criteria in different 
Criteria rows of that field. You can also create an Or condition by typing criteria in 
different Criteria rows of two or more fields. For example, to find all customers with 
contract dates on or before January 1, 2001 or all those with credit limits above 
$3,000, you would type <=1/1/01 in the Criteria row of the Contract Date field and 
>3000 in the or row of the Credit Limit field. 
 
You can create additional Or and And conditions by typing criteria into the Criteria 
row, the or row, or any row below the or row. Any criteria entered into the same 
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Criteria row creates an And condition, any criteria entered into different rows creates 
an Or condition, and you can even create a combination of And and Or conditions. 

 
Creating an Or condition 

 
  

 
Criteria entered in the same Criteria row across the design 
grid create an And condition, and criteria entered in different 
Criteria rows create an Or condition. 

  

 
You can also add criteria using the Expression Builder by 
selecting the desired Criteria row and clicking the Build 
button on the Query Design toolbar or by right-clicking the 
Criteria row and selecting the Build command. 

  

 
You can also create an Or condition for a single field in the 
Criteria row using the Or operator. Typing Northeast Or 
Southeast Or Central into the Criteria row of the Region 
field finds all records in any one of the three regions. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row of the desired field. 

3. Type the desired criterion. 

4. Select the or row under the same field. 

5. Type the second criterion. 

6. Press [Enter]. 
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USING THE BETWEEN AND OPERATOR 

 Discussion 
You can use the Between And operator to find data that includes or falls between two 
stated values. To find all records of customers with credit limits between 1000 and 
2000, for example, you would enter Between 1000 And 2000 in the Criteria row of 
the Credit Limit field. 
 
The Between And operator can be used in text, numeric, or date fields. 
 

  

 
The Between And operator is inclusive; all records with 
values that include or fall between the stated criteria are 
included in the recordset. 

  

 
You can also use the Expression Builder by selecting the 
desired Criteria row and clicking the Build button on the 
Query Design toolbar or by right-clicking in the Criteria row 
and selecting the Build command. 

  
 

  

 
Spaces must be included between the criteria and the words 
Between and And. If you do not include the proper spacing, 
the Data type mismatch in criteria expression error message 
will appear. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row of the desired field. 

3. Type Between, the first value in the range, And, and the last value in 
the range. 

4. Press [Enter]. 
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USING THE EXPRESSION BUILDER 

 Discussion 
When you enter criteria, you are actually creating an expression. Expressions are 
calculations and can include database objects, operators, and values. Objects range 
from table fields to controls in a form. Operators are standard mathematical operators 
used in calculations (such as +, -, *, /, (), <>). Values can be numbers, dates, text, and 
built-in functions, as well as field, control, and property identifiers. 
 
You can create an expression by typing the expression elements, or you can use the 
Expression Builder. The Expression Builder is a tool that provides all the elements 
needed to build the expression. 
 
The Expression Builder displays the Expression box in its top pane, a row of operator 
buttons below the Expression box, and three lower panes that display categories, 
subcategories, and values, respectively. 
 
New expressions appear in the Expression box. You can use a combination of 
methods to build a new expression. You can type some elements of the expression and 
select others (such as operators, functions, and values) from the element panes. If you 
make a mistake, the Undo button allows you to undo previous actions, one at a time. 
Additionally, you can select and delete any elements you want to remove from the 
Expression box. 

 
Using the Expression Builder 
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The Expression Builder is available in Design view for any 
database object for which you need to create an expression. 
For example, you can use the Expression Builder to create a 
validation rule for a table field. 

  

 
You can insert an element from an element pane into the 
Expression box by double-clicking the element or by 
selecting it and clicking the Paste button in the Expression 
Builder. 

  
 

  

 
Be careful to single-click when expanding a subcategory; 
double-clicking a subcategory inserts the first subcategory 
value. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row under the desired field. 

3. Click the Build button  on the Query Design toolbar. 

4. Expand categories in the lower, left pane as necessary, and then click 
any category to display its subcategories in the center pane. 

5. Click the desired subcategory in the center pane. 

6. Double-click a subcategory in the center pane or a value in the right 
pane to insert it into the Expression box. 

7. To enter a value, select existing text or position the insertion point as 
needed in the Expression box. 

8. Type the desired value. 

9. Complete the expression. 

10. Select OK. 
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USING A WILDCARD CHARACTER 

 Discussion 
You can use a wildcard in a query in place of one or several characters. Wildcard 
characters are helpful when you want to find criteria with a pattern (such as all last 
names beginning with M), or if you are not sure exactly how values you want to find 
appear (such as the correct spelling—Kline or Klein). 
 
The two most common wildcards are listed in the following table: 

 
Wildcard Used for Example 

? Any single letter 
or number 

Sm?th finds Smith and Smyth, 
whereas ?andy finds Sandy, Randy, 
etc. 

* One or more 
letters or 
numbers 

M* finds all records that start with 
M; 8/*/00 finds all dates in August, 
2000; and *ball* finds all records 
that have the word ball anywhere in 
the field 

 
 

  

 
Wildcards are not case-sensitive (for example, *ill finds Bill 
and bill). 

  

 
When you use wildcard characters (? and *), Access 
automatically inserts the word Like before the criteria and 
quotation marks (“ ”) around text. 

  

 
You can also use the Expression Builder by selecting the 
desired Criteria row and clicking the Build button on the 
Query Design toolbar or by right-clicking the Criteria row 
and selecting the Build command. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row of the desired field. 

3. Type the desired criteria, using wildcards as appropriate. 
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4. Press [Enter]. 

 



 

 

LESSON 10 -  
USING ONLINE HELP  

In this lesson, you will learn how to: 

• Work with online Help  

• View ScreenTips  

• Use Help Contents  

• Use Help window features  

• Use the Help Answer Wizard  

• Use the Help Index  
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WORKING WITH ONLINE HELP 

 Discussion 
If you need assistance on any Access topic or task, you can use Access’s extensive 
Help facility. There are several ways in which you can get help: the Office Assistant, 
Ask a Question, and the Microsoft Access Help dialog box. 
 
Access provides assistance through the Microsoft Access Help command, which 
launches the Office Assistant, if it is enabled. If the Office Assistant is disabled, you 
can directly access the Help window, which includes the Contents, Index, and Answer 
Wizard components. These components allow you to scroll through a table of 
contents, search for a specific word or phrase based on a keyword, or search based on 
a question you type, respectively. 
 
The What’s This? command can be used to display a ScreenTip. If you have access 
to the Internet, you can use the Office on the Web command to connect to the 
Microsoft Office web site, from where you can download free programs, access on-
line support, and get the latest Microsoft product information. The Activate Product 
command provides an on-line method of purchasing and downloading Microsoft 
software and updates. 
 
On the Sample Databases submenu, Access includes the Northwind sample database 
and sample project, which you can use as practice databases. You may need to install 
the sample databases. 
 
The Detect and Repair command reviews the previous install process and finds and 
fixes problems that may have developed during or since the initial software 
installation. However, this feature cannot repair corrupted data files. 
 
You can use the About Microsoft Access command to view copyright and licensing 
information about the program. The About Microsoft Access window contains a 
System Info button, which displays information about your computer, and a Disabled 
Items button, which displays any items that prevent Access from functioning 
properly. A Tech Support button provides help on getting product support. 
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The Access Help menu 

 
  

 
If the Office Assistant is enabled, you can disable it by 
deselecting the Use the Office Assistant option on the 
Options page in the Office Assistant dialog box. 

  

 
You can also open the Microsoft Access Help window by 
selecting the Microsoft Access Help link at the bottom of the 
New File task pane or by clicking the Microsoft Access Help 
button on the Standard toolbar. 

  
 

VIEWING SCREENTIPS 

 Discussion 
If you are unsure of the name or function of a menu command or of any other object 
in a window, you can use a ScreenTip to view either the object name or a description 
of the object. Although the default ScreenTip only displays the name of an object, you 
select the What’s This? command from the Help menu to access more information. 
 
When the What’s This? feature is activated, the mouse pointer appears with a 
question mark and the ScreenTip appears when you click an object. 
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The Search button ScreenTip 

 
  

 
You can also access the What’s This? feature by pressing the 
[Shift+F1] key combination and clicking the object for which 
you want help. 

  
 

 Procedures 

1. Select the Help menu. 

2. Select the What’s This? command. 

3. Click the button or object with which you want help. 

4. Click anywhere in the slide to hide the What’s This? ScreenTip. 

 

USING HELP CONTENTS 

 Discussion 
The Microsoft Access Help window is composed of two panes. The pane on the left 
contains the three help tabs: Contents, Answer Wizard, and Index. The pane on the 
right contains the information pertaining to the selected help topic. 
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The Contents page displays a list of general help categories and topics. From this list, 
you can select the category for a particular group of features or functions or a specific 
help topic. This page is structured similar to a standard table of contents. The table is 
expandable; when you double-click a category, related categories and help topics 
appear. 
 
When you select the help topic you want to view, it appears in the right pane of the 
help window. You can click underlined, colored text in the right pane to display 
additional help information. Many help topics include a Show All link at the top of 
the pane that you can use to display all the hidden information in the pane. 
 
If you want a paper copy of the help topic, you can use the Print button in the help 
window to print the current topic. 

 
Using Help Contents 

 
  

 
You can also expand and collapse help categories on the 
Contents page by clicking the plus or minus sign next to the 
desired category. 

  

 
The Microsoft Access Help command on the Help menu 
directly opens the help window only if the Office Assistant is 
disabled. Selecting a topic in the Office Assistant, however, 
always opens the corresponding help window. 

  

 
You can resize the Microsoft Access Help window by 
dragging an edge or a corner or resize the individual panes 
within the window by dragging the vertical splitter bar 
between panes. 
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 Procedures 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 

3. Select the Microsoft Access Help command. 

4. Select the Contents tab. 

5. Expand the Microsoft Access Help category, if necessary. 

6. Expand categories as needed to find the desired help topic. 

7. Select the desired help topic. 

 

USING HELP WINDOW FEATURES 

 Discussion 
The Microsoft Access Help window displays two panes: the categorized help contents 
appear in the left pane and the selected help topic appears in the right pane. 
 
You can use the Show and Hide buttons at the top of the window to hide the tabs in 
the left pane or to show both panes. Hiding the left pane decreases the size of the 
window. This option allows you to continue working in the database window while 
you reference the selected help topic in the right pane of the Help window. 
 
You may want to be able to view the help window and your database application 
window simultaneously, so that you can follow the help directions. When the help 
window opens, it overlays the database window. The Auto Tile button arranges the 
two windows side-by-side, so that both are visible. You can now type in the database 
window without hiding the help window, and you can use the horizontal and vertical 
scroll bars to view more text. When the windows are tiled, the help window displays 
the Untile button, which allows you to untile the windows. 
 

  

 
You can also show or hide the help tabs by selecting the Show 
Tabs or Hide Tabs commands from the Options button in the 
Microsoft Access Help window. 

  

 
Other buttons in the Microsoft Access Help window can be 
used to print help topics and to navigate forward and 
backward to previous topics. 
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 Procedures 

1. Open the Microsoft Access Help window. 

2. Click the Hide button  or the Show button  at the top of 
the Microsoft Access Help window to hide or show the help tabs 
respectively. 

3. Click the Auto Tile button  to tile the database and help 

windows or the Untile button  to untile the windows.  

 

USING THE HELP ANSWER WIZARD 

 Discussion 
You can use the Answer Wizard page in the Microsoft Access Help window to 
quickly locate help topics based on questions you ask. The Answer Wizard page 
functions in much the same way as the Office Assistant and the Ask a Question box 
on the menu bar. A list of the help topics pertaining to the typed question appears 
when you search using the Answer Wizard. 
 
Questions entered into the Answer Wizard also appear in the Ask a Question list. 
 

USING THE HELP INDEX 

 Discussion 
The Index page in the Microsoft Access Help window provides an alphabetical index 
of available help topics. 
 
The Index page enables you to search for a topic using a keyword. You can either 
type a keyword into the Type keywords box or pick a keyword from the alphabetical 
list under Or choose keywords. After typing or selecting a keyword and then 
selecting Search, an index of available help topics appears. You can then select the 
desired topic. 
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Using the Help Index 

 
  

 
To perform a subsequent search on a different subject, select 
the Clear button to clear the previous search criteria, and then 
enter the new search criteria. 

  
 

 Procedures 

1. Open the Microsoft Access Help window. 

2. Select the Index tab. 

3. Type the keyword for which you want to search in the Type 
keywords box or select it from the Or choose keywords list box. 

4. Select Search to search for the keyword, or double-click a keyword 
in the Or choose keywords list box. 

5. Click the desired topic from the Choose a topic list box. 

 



 

 

LESSON 11 -  
CREATING BASIC FORMS  

In this lesson, you will learn how to: 

• Use forms  

• Use the Form Wizard  

• View records in a form  

• Print records in a form  

• Base a form on a query  

• Use AutoForm  

• Add a record using a form  
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USING FORMS 

 Discussion 
Forms, like datasheets, can be used for viewing and editing data. However, they can 
also be used to present data in a more attractive format. Forms are usually designed to 
display all the fields for a single record within the form window, eliminating the need 
to scroll. You can also display data from related tables in one form. 
 
Access provides six basic types of forms: columnar, tabular, datasheet, justified, 
PivotTable and PivotChart. In a columnar form, the field names are listed on the left 
side of the form and the field values appear in a column on the right. If space permits, 
there can be more than one column. 
 
In a tabular form, the field names are listed across the top of the form and the values 
appear in the corresponding columns beneath them. A datasheet form appears similar 
to Datasheet view. Both the tabular and datasheet forms display data in a table layout. 
 
In a justified form, the field names and values appear in alternate rows, evenly spaced 
across the page. Field values appear under the corresponding field names. 
 
A PivotTable form allows you to quickly create a form by dragging fields as desired 
in PivotTable view. Similar to a PivotTable form, a PivotChart form allows you to 
create a chart or graph by dragging fields as desired in PivotChart view. 
 

USING THE FORM WIZARD 

 Discussion 
You can use the Form Wizard to quickly and easily create a form. The Form Wizard 
guides you through the process. First, you must choose the table or query on which 
you want to base the form, and then you can select the fields you want to include. 
Next, you select the desired type of form layout: columnar, tabular, datasheet, 
justified, PivotTable, or PivotChart. You can then select a style from a variety of 
predefined styles provided by Access. Finally, you must name the form. 
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The Customer Data Entry form 

 
  

 
If you base a form on multiple tables, the tables must all be 
related. In addition, the Form Wizard will prompt you to select 
how you want to group the fields on the form. 

  

 
You can also activate the Form Wizard by double-clicking the 
Create form by using wizard option in the Forms object list 
in the Database window, by selecting the Insert menu and the 
Form command, or by clicking the New Object button on the 
Database toolbar and selecting the Form command. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Form Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query on which you want to base the form. 

7. Add the desired fields to the Selected Fields list box, or add all the 
fields. 

8. Select Next >. 

9. Select the desired form layout. 

10. Select Next >. 
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11. Select the desired form style. 

12. Select Next >. 

13. Type the desired form name. 

14. Select Finish. 

 

VIEWING RECORDS IN A FORM 

 Discussion 
Navigating records in a form is similar to navigating records in Datasheet view. You 
can use the navigation buttons at the bottom of the window to display records in a 
form. The following navigation buttons are available in Form view: 

 
Button Description 

 Displays the first record 

 Displays the previous record 

 Displays the next record 

 Displays the last record 

 
 

  

 
You can also press the [Ctrl+Home] key combination to 
display the first record, the [Ctrl+End] key combination to 
display the last record, and the [Page Up] and [Page Down] 
keys display the previous and next records, respectively. 

  

 
You can also go directly to a record by selecting the number in 
the Record box (located within the navigation buttons at the 
bottom of the window), typing the number of the record you 
want to display, and pressing the [Enter] key. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Open a form in Form view. 
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3. Click the Last Record button  at the bottom of the form 
window. 

4. Click the First Record button  at the bottom of the form 
window. 

5. Click the Next Record button  at the bottom of the form 
window. 

6. Click the Previous Record button  at the bottom of the form 
window. 

 

PRINTING RECORDS IN A FORM 

 Discussion 
You can print an open form. 
 
If you use the Print button to print all the data, Access fits as many whole forms as 
possible on each page; Access will not break a form in the middle. If a form is large 
and there are numerous records in it, you may be using a large amount of paper and 
printer time. 
 
If you use the Print dialog box, you can print all records, only specified pages, or all 
selected records, thereby saving time and paper. 
 

  

 
You can also open the Print dialog box by right-clicking an 
object in the Database window and selecting the Print 
command. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Open a form in Form view. 

3. Select the File menu. 

4. Select the Print command. 

5. Select the desired options. 
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6. Select OK. 

 

BASING A FORM ON A QUERY 

 Discussion 
Forms can extract information from a query as well as from a table. 
 
If the query recordset cannot be updated, you will not be able to edit the form or add 
records to it. Nevertheless, a form can be used to present query data in a more 
attractive manner. 
 

  

 
You can also activate the Form Wizard by double-clicking the 
Create form by using wizard option in the Forms object list 
in the Database window, by selecting the Insert menu and 
then selecting the Form command, or by clicking the New 
Object button on the Database toolbar and selecting the 
Form command. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Form Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the query on which you want to base the form. 

7. Add the desired fields to the Selected Fields list box, or add all the 
fields. 

8. Select Next >. 

9. Select the desired form layout. 

10. Select Next >. 

11. Select the desired form style. 

12. Select Next >. 
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13. Type the desired form name. 

14. Select Finish. 

 

USING AUTOFORM 

 Discussion 
The fastest way to create a form is to use AutoForm. AutoForm automatically creates 
a simple columnar, tabular, datasheet, PivotTable, or PivotChart form from the 
selected table or query, without needing any input. However, you must select a table 
or query before AutoForm can create the form. All fields in the table or query will 
appear on the form, and the title of the form is the name of the table or query. 
 
AutoForm does not save the form for you automatically. When you close the form for 
the first time, Access prompts you to save it. 
 

  

 
AutoForm creates a form using the defaults for the selected 
form type. After AutoForm has created a form, however, its 
formatting can be modified in Design view. 

   

 
You can also use AutoForm to create a form based on the 
selected table or query by selecting the Insert menu and the 
AutoForm command or by clicking the New Object button 
on the Database toolbar and selecting the AutoForm 
command. When you use one of these methods, the form 
always appears in a standard columnar format. 

  

 
AutoForm can also be used to produce a formatted columnar 
or tabular report. 

  
 

 Procedures 

1. Select the Forms object list. 

2. Select the  New button on the Database window toolbar. 

3. Select the desired AutoForm option. 

4. Select the Choose the table or query where the object’s data 
comes from list. 
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5. Select the desired table or query. 

6. Select OK. 

 

ADDING A RECORD USING A FORM 

 Discussion 
Forms are frequently used to add records to one or more tables. It can be easier to 
work in a well-designed form than in the underlying table because forms are usually 
designed to display all the fields for a single record within the form window, 
eliminating the need to scroll. 
 
You can use the [Enter] key to move between fields as you enter data. If you want to 
skip one or more fields, you can press the [Tab] key until the insertion point appears 
in the desired field, or you can click in the field in which you want to enter data. 
When you press the [Enter] key after entering data in the last field in a record, Access 
automatically saves the record and displays a blank form for entering another record. 
 

  

 
You can use the [Shift+Tab] key combination to move to the 
previous field. 

  

 
You can also use the New Record button on the Form View 
toolbar to add a record to a form. 

  
 

 Procedures 

1. Display the Forms object list. 

2. Open the form in Form view. 

3. Click the New Record button  at the bottom of the window. 

4. Type the desired data into the first field of the new record. 

5. Press [Enter]. 

6. Enter data in additional data into the remaining fields as desired. 

 



 

 

LESSON 12 -  
CREATING BASIC REPORTS  

In this lesson, you will learn how to: 

• Use reports  

• Use the Report Wizard  

• Use print preview - reports  

• Print pages of a report  

• Group and summarize report data  

• Base a report on a query  

• Use AutoReport  
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USING REPORTS 

 Discussion 
Although you can print records from a table or form, a report provides more precise 
control over the final output. Reports can include page headers and footers, calculated 
totals and subtotals, and even graphics. In addition, reports can be used for invoices, 
orders, presentations, and mailing labels. 
 
There are two basic types of reports: columnar and tabular. In a columnar report, the 
field names are listed on the left side of the page, and the field values are listed on the 
right. If space on the page permits, there can be more than one column. In a tabular 
report, the field names are listed across the top of the report, and the field values 
appear in the corresponding columns. 
 
Reports can include data from a single table or related tables. Reports can also be 
based on queries. 
 

  

 
You cannot edit data in a report. 

  
 

USING THE REPORT WIZARD 

 Discussion 
You can use the Report Wizard to quickly and easily create a report. The basic steps 
needed to create a report using the Report Wizard are as follows: 

 
1. Select the table(s) you want to use. 

2. Select the fields you want to include. 

3. Group the data. 

4. Add grouping levels. 

5. Sort the data. 

6. Select a layout. 

7. Select a style. 

8. Name the report. 
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When you have finished creating a report, the Report Wizard displays it in print 
preview. Print preview allows you to view the report before you print it. 

 
Using the Report Wizard 

 
  

 
If you base a report on only one table, the Report Wizard does 
not ask you to specify a table on which to group the data. 

  

 
If you include fields from unrelated tables in the report, 
Access closes the Report Wizard and opens the Relationships 
window so that you can create the necessary relationship. 

  

 
You can also activate the Report Wizard by double-clicking 
the Create report by using wizard option in the Reports 
object list in the Database window, by selecting the Insert 
menu and the Report command, or by clicking the New 
Object button on the Database toolbar and selecting the 
Report command. 

  
 

 Procedures 

1. Display the Reports object list. 

2. Select the  New button on the Database window toolbar. 
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3. Select Report Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query on which you want to base the report. 

7. Add the desired fields to the Selected Fields list box. 

8. To add another table to the report, select the Tables/Queries list. 

9. Select the desired table or query. 

10. Add the desired fields to the Selected Fields list box. 

11. Select Next >. 

12. Select the desired option in the How do you want to view your 
data? list box. 

13. Select Next >. 

14. Select the desired grouping level in the Do you want to add any 
grouping levels? list box. 

15. Select Next >. 

16. To sort the records, select the 1 list. 

17. Select the field by which you want to sort. 

18. Select Next >. 

19. Select the desired report layout. 

20. Select the desired report orientation. 

21. Select Next >. 

22. Select the desired report style. 

23. Select Next >. 

24. Type the desired report name. 

25. Select Finish. 

 

USING PRINT PREVIEW - REPORTS 

 Discussion 
When you open a report, it appears in print preview. Print preview allows you to see 
how the printed report will look before you print it. 
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Print preview provides options for viewing the report. By default, the report appears 
magnified at 100%, the same size as the printout. You can zoom out to see more of the 
report or zoom in to see a portion of the report in more detail. The Zoom list in print 
preview allows you to choose from several magnification options, from as small as 
10% to as large as 500% or 1000%. 
 
You can display a report in One Page, Two Pages, or Multiple Pages view. The 
buttons at the bottom of the window allow you to navigate pages, and the scroll bars 
allow you to view different areas of a page. 

 
Using print preview 

 
  

 
You can also access print preview by right-clicking a report in 
the Database window and selecting the Print Preview 
command. 

  

 
You can also use the Zoom list on the Print Preview toolbar 
to switch the magnification between 100% and to fit the 
window. 

  
 

 Procedures 

1. Display the Reports object list. 

2. Select the report you want to preview. 

3. Select the  Preview button on the Database window toolbar. 
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4. Click the area of the report page you want to magnify to 100%. 

5. Click anywhere in the report page to change the magnification back 
to fit the window. 

6. Click the Two Pages button  on the Print Preview toolbar to 
display two pages of the report. 

7. Click the One Page button  on the Print Preview toolbar to 
display one page of the report. 

8. Click the Next Page button  at the bottom of the report window 
to display the next page of the report. 

9. Click the Last Page button  at the bottom of the report window 
to display the last page of the report. 

10. Click the Previous Page button  at the bottom of the report 
window to display the previous page of the report. 

11. Click the First Page button  at the bottom of the report window 
to display the first page of the report. 

 

PRINTING PAGES OF A REPORT 

 Discussion 
You can print specific pages of a report. This option is useful if the report contains 
numerous pages, and you only need information from one or more particular pages. 
The Print dialog box allows you to specify the pages you want to print. 
 

  

 
You can print a report from the Database window or from 
print preview. 

  

 
To print an entire report, select it and click the Print button on 
the Database toolbar. 

  

 
You can also open the Print dialog box by right-clicking the 
report you want to print and selecting the Print command. 
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 Procedures 

1. Display the Reports object list. 

2. Select the report you want to print. 

3. Select the File menu. 

4. Select the Print command. 

5. Select the Pages option. 

6. Type the number of the first page you want to print. 

7. Select the To box. 

8. Type the number of the last page you want to print. 

9. Select OK. 

 

GROUPING AND SUMMARIZING REPORT DATA 

 Discussion 
The Report Wizard provides options for grouping and summarizing report data. You 
can organize your report by selecting the fields into which you want to group data. If 
you create more than one group, you can prioritize the groups into levels. 
 
In addition to grouping data by a field, you can add grouping intervals. Grouping 
intervals vary, depending upon the selected field. For instance, a date field can be 
grouped by month, quarter, year, etc.; a numeric field can be grouped by numeric 
intervals of 10s, 50s, 100s, etc.; and a text field can be grouped by its first letter, 
second letter, etc. 
 
If you have included a field with numeric data in your report, you can add summary 
calculations. Summary calculations include Sum, Avg (average), Min (minimum), 
and Max (maximum). If you select the Sum calculation, you can include a calculated 
percentage of the total for each group. You can also display just the summary 
calculations in the report or both the field data (details) and the summary calculations. 
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Adding a grouping interval 

 
  

 
If you are grouping on multiple fields, you can use the up and 
down Priority buttons to change the order of the groups in the 
Report Wizard. 

  

 
You can add a new field to a specific location in a report by 
first selecting the field in the Selected Fields list box below 
which you want to insert the new field. 

  

 
You must use Design view to add grouping levels and 
summaries to an existing report. 

  
 

 Procedures 

1. Display the Reports object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Report Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query on which you want to base the report. 

7. Add the fields you want to include in the report to the Selected 
Fields list box. 
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8. Select Next >. 

9. Select the desired grouping option from the How do you want to 
view your data? list box. 

10. Select Next >. 

11. Select the desired grouping level from the Do you want to add any 
grouping levels? list box, if applicable. 

12. Select Grouping Options. 

13. Select the Grouping intervals list. 

14. Select the desired interval. 

15. Select OK. 

16. Select Next >. 

17. If you have included a Number data type field, select Summary 
Options. 

18. Select the desired summary options. 

19. Select OK. 

20. When you have finished selecting options from the Report Wizard, 
select Finish. 

 

BASING A REPORT ON A QUERY 

 Discussion 
You can use a query as the basis for a report. The query recordset appears as the 
report data. The report is updated each time it is opened or printed to reflect changes 
made to queried data. 
 

  

 
You can also activate the Report Wizard by double-clicking 
the Create report by using wizard option in the Reports 
object list in the Database window, by selecting the Insert 
menu and the Report command, or by clicking the New 
Object button on the Database toolbar and selecting the 
Report command. 
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 Procedures 

1. Display the Reports object list. 

 2. Select the  New button on the Database window toolbar. 

3. Select Report Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the query on which you want to base the report. 

7. Add the desired fields to the Selected Fields list box, or add all 
fields. 

8. Select Next >. 

9. Select the desired grouping option from the How do you want to 
view your data? list box. 

10. Select Next >. 

11. Select the desired grouping level from the Do you want to add any 
grouping levels? list box, if applicable. 

12. Select Next >. 

13. Select the 1 field list. 

14. Select the first field by which you want to sort. 

15. Select additional sort fields, if desired.  

16. Select Next >. 

17. Select the desired report layout. 

18. Select the desired report orientation. 

19. Select Next >. 

20. Select the desired report style. 

21. Select Next >. 

22. Type the desired report name in the What title do you want for 
your report? box. 

23. Select Finish. 
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USING AUTOREPORT 

 Discussion 
You can use AutoReport to create a report quickly. AutoReport automatically creates 
a simple columnar or tabular report from the selected table or query without 
displaying any dialog boxes or needing any input. You must, however, first select the 
table or query. All fields in the table or query will appear in the report, and the report 
title will be the same as the table or query name. 
 
AutoReport does not automatically save a report; the first time you close the report, 
Access prompts you to save it. 
 

  

 
The AutoReport Wizard creates the report using the most 
recently used report settings. You can switch to Design view 
to change the formatting of an existing report. 

  

 
You can also activate the AutoReport Wizard by first selecting 
the table or query you want to use, and then selecting the 
Insert menu and the AutoReport command or clicking the 
New Object button on the Database toolbar and selecting the 
AutoReport command. When you use either of these 
methods, the report appears in a standard columnar format, 
with no formatting, headers, or footers. 

  
 

 Procedures 

1. Select the Reports object list. 

2. Select the  New button on the Database window toolbar. 

3. Select the desired AutoReport option. 

4. Select the Choose the table or query where the object’s data 
comes from list. 

5. Select the desired table or query. 

6. Select OK. 
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